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Word Processing

Windows 95
The intention of this section is to instruct basic word processing skills such
as creating, editing, formatting, saving and closing a new document.
Microsoft Works is the program that will be utilized.  However, once these
skills are learned, they can easily be transferred to other word processing
programs such as ClarisWorks or Microsoft Word.  For more information
about using ClarisWorks and Microsoft Word see the information at the end
of this tutorial.

 Hands-On

This section contains step-by-step instructions for using the word
processing program of Microsoft Works.  When you are asked to tap, or
lightly strike, a certain key on the keyboard it will appear in ALL CAPS and
in boldface.  In addition, if you are asked to use the keyboard to type or
key-in text, the designated text will appear in “quotations” and in a
typewriter font.

Opening Microsoft Works - Word Processing

1a. To open Microsoft Works, use the left-hand portion of the
trackball pad and click the Start button, positioned at the lower
left-hand corner of your screen, once.

2a. Place the pointer on Programs.  Move the pointer horizontally to
the right into the next window.

3a. A pop-up menu appears, move the pointer to select Microsoft
Works 4.0.  Another pop-up window appears; move the pointer
to the right again and select and click on Microsoft Works 4.0.

4a. When the Works Task Launcher appears, click on the Works
Tool tab at the upper right portion of the window.

5a. In the next window, click on the      W     ord Processor button.

6a. A blank document window Unsaved Document 1 is now
visible.

Microsoft Works
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Menus

To manipulate a menu:
1b. Move the pointer above or on one of the menu names on the Menu

Bar at the top of the window screen (e.g., File or Edit).  Click on
the menu name.

2b. Move the pointer to select and click on the desired command.
Click again on the menu heading to close if no selection is desired.
If the command has an ellipse (...) after it, a dialog box should
appear once the command is selected.

 Additional Information
Icon Identification:
Place the pointer on the lower portion of each icon on the Tool Bar.  A
box will appear below it which identifies the purpose of each button.

Creating a New Document

When the word processing program starts, a blank document appears on the
screen.  In this document we will enter new text, then edit and format the
text.

Note the blinking short vertical line within the document body called the
insertion point which marks the position in the document where keyed in
(typed) text appears.  The insertion point may be moved by using the mouse
or the arrow keys on your keyboard.

A group of three buttons on the Tool Bar control justification of the text.
The first button justifies text to the left  margin.  The second button justifies
text to the page center.  The third justifies text to the right margin.

\1   \2   \3

Entering Text

1c. In the new document window, key in the following sentences
exactly as shown:

The Word Processor program in Works
automatically advances text to the next line
when the test reaches the right margin of the
document.  This feature is known as word-
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wrap.

2c. Tap the ENTER key twice to create a blank line between the
paragraphs.  Key in the following sentence:

You use the Enter key to end paragraphs and
insert new lines of text.  If you tap the
Enter key twice it creates a blank line in
your document.

Editing Text

1d. In the first sentence change the word “test” to “text” by placing
the insertion point to the right of the character “s” and tapping the
BACKSPACE key.  This erases the “s” and moves the
insertion point to the left.

2d. Type the correct letter “x”.  Notice this inserts the x in the correct
position and moves the rest of the text to the right.

3d. To indent the first sentence of each paragraph move the insertion
point to the left of the word “The” in the first sentence and tap the
TAB key.

4d. Indent the second paragraph.

Formatting Text

Formatting is used to change the appearance of text allowing you to
emphasize text and make documents look more professional.  Works has
several ways to format characters. The style of the text may be formatted as
bold, italic,     underline    and combinations of these styles.  Formatting also
includes changing fonts and font sizes. Formatting text may be
accomplished using Works menu commands or by using buttons provided
in the Tool Bar.

Formatting Styles

In the following steps we will apply format changes to the first paragraph of
our document.  We will bold the word “Works” and underline the phrase
“Word Processor.” With these steps we learn that existing text must be
selected (highlighted) before formatting may be applied.  We will also add a
new paragraph to the document to learn how to apply format to text as it is
typed into our document.

1e. Select the word “Works” by placing the insertion point to the left
of the “W” in “Works”, click and hold, and drag the mouse to
the right across the word until it is highlighted, and release.
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2e. Place the mouse over the Format menu on the menu bar.  Click
on the Format menu.

3e. Select and click the Font and Style command. Go to the Style
box in the lower left-hand portion of the window, click on Bold.
Click OK to exit window.

4e. Click anywhere on another part of the document to deselect the
highlighted text.

 Special Note
Short-cut:  Highlight the word, click on the B  button on the tool bar to
select Bold, click elsewhere on the document to deselect.  (This also works
for Italic I, and     underline        U    .)

5e. To change the format to underline, select the text “Word
Processor”.

6e. Click on the     U     button on the toolbar.  Click on another part of the
document to deselect.

7e. Place the insertion point at the end of the second paragraph, click,
and tap Enter twice to create a blank line.

8e. Tap the TAB key to create an indent and then key in the
following:

Formatting features may be applied to
existing text in a document or while entering
text.

9e. In the toolbar click on the I button to activate the italic format and
then key in the following:

Changing the style of text as you type
requires that you first activate the format
feature, then type your text and finally turn
off the feature.

10e. In the Tool Bar click on the I  button to turn off the italic format.
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Note: At this time your new document should look similar to the following
document:

The Word Processor program in Works automatically advances text to the
next line when the text reaches the right margin of the document.  This
feature is known as word-wrap.

You use the Return or Enter key to end paragraphs and insert new lines of
text.  If you tap the Return or Enter key twice it creates a blank line in
your document.

Formatting features may be applied to existing text in a document or while
entering text.  Changing the style of text as you type requires that you first
activate the format feature, then type your text and finally turn off the
feature.

Formatting Fonts

In the following steps we will change the second sentence of the first
paragraph to font type Arial.  We will then change the second paragraph to
font size 14.

1f. Place the insertion point anywhere in the second sentence of the
first paragraph, hold down the Control key and click the mouse
to select the entire sentence.

2f. Click the arrow button on the right edge of the Font box in the
toolbar.

3f. Scroll up the alphabetical listing using the upper arrow key. (Click
and hold the arrow to scroll till Arial appears.)  Move the cursor
to the left onto Arial to select, click.

4f. Select the second paragraph of your document by placing your
insertion point to the left of the first word “You”, clicking and
dragging downward and to the right over the text until the entire
second paragraph is highlighted, and release.

5f. Click on the arrow of the button on the right of the Font-size box
in the toolbar and hold.

6f. Use the mouse to scroll the list downward and release on 1 4.
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Note: At this time your new document should look similar to the following
document:

The Word Processor program in Works automatically advances text to the
next line when the text reaches the right margin of the document.  This
feature is known as word-wrap.

You use the Enter key to end paragraphs and insert new lines
of text.  If you tap the Return key twice it creates a blank line
in your document.

Formatting features may be applied to existing text in a document or while
entering text.  Changing the style of text as you type requires that you first
activate the format feature, then type your text and finally turn off the
feature.

You may select any font style and size before you begin keying in your
document. The entire document will then be formatted as per your selection.

Adding Bullets

Create bulleted lists easily by using the Bullet button on the Ruler toolbar
below the title bar.  A bulleted list is useful for grouping related items and
making them  easier to read. In the following steps we will add a short
bulleted list to our document.

1g. Move the insertion point to the end of the last sentence.  Create a
blank line at the bottom of the document.  (Tap Enter twice.)

2g. Key in:
Types of Formatting:

3g. Tap the ENTER key.

4g. In the Tool Bar click on the bullet button.

5g. Key in the following (tapping ENTER    after each item     ):

Styles

Fonts

Paragraphs
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6g. Click on the Bullet button to turn the button feature off.  (Be sure
you have tapped Enter after keying the last entry before clicking
the bullet button off.)

Note: At this time your new document should look similar to the document
below:

The Word Processor program in Works automatically advances text to the
next line when the text reaches the right margin of the document.  This
feature is known as word-wrap.

You use the Return or Enter key to end paragraphs and insert
new lines of text.  If you tap the Enter or Return key twice it
creates a blank line in your document.

Formatting features may be applied to existing text in a document or while
entering text.  Changing the style of text as you type requires that you first
activate the format feature, then type your text and finally turn off the
feature.

Styles
Fonts
Paragraphs

Saving a Document

When you create and edit a document, the changes you make are
temporarily saved in the memory of your computer.  If you quit Works
without saving your document it will not be available to you at a later time.
Therefore, if you wish to access a document at a later time you must chose
to save it to a disk or to the hard drive.

In the File menu on the menu bar, you will notice that there is a Save
command and a Save As command.  The first time you save a document,
whether you chose Save or Save As, the program will automatically display
the Save As dialog box.

    Save   :
•  Used to save ongoing-changes periodically as you create your

document.

    Save As   :
•  Used to save the document the first time when you assign a name.
•  Used to save the document when you want an additional copy of the

document.  You have to save as a different name (rename) or to a
different location (hard drive, disk, folder, etc.).
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In the following steps we will save our document as ”basic word-
processing” to a diskette.  Insert a disk into the slot on the front of your
computer.  (The metal edge should be towards the computer.)

1h. Place the mouse over File menu on the menu bar and click.

2h.  Select and click on Save As.

3h. Works displays the Save As dialog box; in the File Name box
type “Basic word-processing.”

4h. To change the location to the diskette, click on the button in the
Save in box.

5h. Select and click on the 3 1/2 Floppy (A:) (diskette) from the
list.

6h.  Click on Save.

 Special Note
Save As:  To use your document in another word-processing program,
such as Claris Works, Microsoft Word or Word Perfect, do a Save As and
Save the document in Text Format. # Under Save as type, use the arrow
to select and click on Text.  Click on Save.  When in any of the above
word-processing programs, use your menu bar File command and select
Open.  You can now find this document listed as Text and open it into the
new program.
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Closing a Document

Always Save before closing a document.  If you forget, the computer will
ask if you want to save your changes.

1i. Place the mouse over and click on File menu.

2i. Select the Close command, and release the button.

3i. Works displays the Startup dialog box.

 Special Note
Short-Cut Key Strokes:
Microsoft Works also allows the user to access the menu commands by
providing short-cut key strokes.  For example, the user may close a Works
window by tapping the CTRL key and the W key simultaneously.

All shortcut key commands are listed to the right of the menu listings.  For
example, click on Edit in the menu bar to see the menu commands and the
corresponding short-cut key strokes.

 Activity

The following instructions need to be utilized with the Word Processing
Activity located in the Activity section of the Workshop Guide or you can
access the Activity from the following URL:
http://www.uni.edu/ietti/uswest/workshop)

1j. To practice the skills you have learned, create a new document
keying in the text in “Word Processing Activity.”

2j. Create a title of your choice.

3j. Edit the document to correct any mistakes you may have made.
Apply necessary format changes to make the document look like
the formatted document.

4j. Finish the story by adding your conclusion to the story

5j. Save the document as “my lucky day” to your diskette and
quit, or exit Works.
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 Additional Information

Microsoft Works Pointer Shapes

When using Microsoft Works the pointer may be displayed as three
different shapes.  The shape of the pointer is dependent on the position on
the screen and produces different actions based on the shape.

The    arrow pointer shape   ; a left-pointing arrow appears when the
pointer is placed over the menu bar, toolbars or scroll bars.

Î  T h e     insertion pointer   ; the shape of a capital letter I appears when the
pointer is placed in the document area and when placed in text boxes
of dialog boxes.

The    selection pointer   ; a right-pointing arrow, appears when the
pointer is located in the far left side of the screen.

Highlighting Text

Before you can make changes or corrections to text, you must select the text
you want to change by highlighting it.  To highlight text, perform the
pointer action described in the following table.

To Highlight: | Do This:
Any text | Click and drag the pointer over the text
A word | Double click on the word
A line | Triple click anywhere on the line.
A sentence | Hold COMMAND key and click anywhere in the

sentence.
A paragraph | Quadruple click anywhere in the paragraph
A range of text | Click once at beginning of selection. Then hold

SHIFT key and click at the end of selection.
Entire document | Triple click in the selection bar.

 Special Note
For more information on ClarisWorks and Microsoft Word see these URLs.

Microsoft Works
http://www.microsoft.com/works/
•  Microsoft Works Clip Art

http://www.microsoft.com/works/html/More/Clipart/clip_fam.htm
•  Microsoft Works School Work

http://www.microsoft.com/works/html/Teachers/School_Works/kidwor
k.htm

ClarisWorks Tutorial
http://milkman.cac.psu.edu/publications/web/publications/cacguide/training/
outlines/indexcworks.html
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